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Tools and Resources.



Overview

BlueVault is a comprehensive, corporate account provisioning ttdt
governsaccess to ALL global digital identity stores and associated applications that use these identities;
Employee and nofEmployee identies alike Throwh integration with Microsoft Sirepoint, Microsoft

ILM 200 and Microsoft SQL Server, BlueVddintity Managerprovides a central solution assuring
compliance to corporat@olicies andstandards

gl BlueVault
[ome]

Home
» Reset my \ Welcome to BlueVault Identity Manager BlueVault Sign In:

To change your password, edit your profile, change your challenge questions ~ Password: 1
and answers or to request a name change, please select the "Self Service” ﬁ
link.

lueChip_’

Cansulting Graup

©2009 Blus Chip Consulting Graup, LLE, All rights reserved.



Access Levels
! dza SNRa | O00S a adzd NS BluddEit Bhe ﬂélﬁ/\ﬁhg r@l@’arel’imai&ble
Roles

StandardUsess ¢ default user role allows for user sekervice functions

Managers; manage their direct reports and request nemployee accounts
Resource Owners manage the resourcedat they own such as Systems, Security Groups,
S5AaGNROdziA2Yy [Aadaz SGOX

ReportingViewersc view audit and compliance reports

Report Builderg, create and publish custom reports

Report Administratorg administer and configure the reporting system

Human Rsourceg; create edit and delete applicant and employee accounts

Site Administrato manage all users at a particular sitemultiple sites
Administratorsg all of the above plus the ability to edit the portal configuration
System Administratorg manage the underlying portal configuration and ILM settings

= =4 =4

=A =4 =4 =8 =8 -8 =9

The different levels of access will show up as navigation tabs at the top efeh@age and quichink
headers on the lethand side.

)i Bluevault -

i Self-Service I Employee I Identity I Resource Owner I Admin I Site Admin I Reports |

Home
. Welcome to BlueVault Identity Manager
Self-Service
Employee . ) .
] To change your password, edit your profile, change your challenge questions
Identity name change, please select the “Self Service” link.

Resource Owner
Admin

Site Admin
Reports

Each of theseoles correspondgo an Active Directory sectyi group. These groups must be managed
viaBlueVaultand should not be directly edited in Active Directory. Modifications to the Active Directory
groups will be overwritten by thBIM synchronization routines.



Self-Service Tasks

Challenge / Response Enroliment

A usermust settheir answers to the challenge / response questions betbiey will have the ability to
resettheir password.

Home
N \ Welcome to BlueVault Identity Manager BlueVault Sign In:

Email: nmployeejn _company.loc
To change your password, edit your profile, change your challenge questions ~ Password:

and answers or to request a name change, please select the "Self Service” -
link.

oEIut‘eChip_/

Camsulting Group

2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Login toBIM

[Cogeut] BN ==e il

Home

] User Self Service
Self-Service

» Change Password
» Edit My Profile $0 chgnge your pasf_s‘wo rd‘, selehct \t‘féz_“ﬁar;gef_lrislsv\:(o rd” link.
» Challenge Questions o update your profile, select the it My Profile” link.

To change your challenge questions and answers, select the “Challenge Questions” link.

» Request Rename To request a rename, select the "Request Rename” link.

» Request New Title

0ElueChip

Consulting Group

®2009 Blue Chip Cansulting Group, LLC. All rights reserved.
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@BlueVault (o] e § )

Home

Self-Service Challenge Questions

» Change Password Please select three verification questions and type in your answers.
» Edit My Profile What is your favarite color? -

,, Challenge -
Questions What is your favorite color? -

» Request Rename
» Request New Title What is your favorite color? -

L
[LSubmi |

QElueChi

ccccccccccccccc

P

2009 Blue Chip Consulting Graup. LLC, Al rights reserved.

T /ftA01 2y GKS &/ KK Sy3S vdzSadiazyaé I dzi O]

0 The quetions will be intheir default language

o {SS a5SFldzZA G [ly3dza IS {StSOlA2yé¢ 06St26 F2NJ
1 Select three different validation questions and enter the answers
¢ /A0l GKS a{doYAlé¢ odzidzy



Password Reset

If a user has already set theanswers to thechallenge questions anithey forget their password they
will have the ability to reet it from BlueVault Identity Manager.

W BlueVault

Home
» resot MyE RN Welcome to BlueVault Identity Manager

o
To change your password, edit your profile, change your challenge questions ~ Password: L ]
and answers or to request a name change, please select the "Self Service”
link.

BlueVault Sign In:

QﬁluechipJ

Cansulting Grow
©2003 Blue Chip Consulting Graup, LLC, All rights reserved.

9 Browse toBIM

1 {86500 GKS awSaslik ad tl a462NRE | dzd O

W BlueVault

Home

, Reset My Reset My Password

Password

Please enter your login name
|emp\0yes]n@companymcal |

QEIm‘eChip_/

Cansulting Group
©2009 Blue Chip Consulting Graup, LLC. All rights reserved

i Entertheir email address
T /ftA01 GCAYR aS¢



W BlueVault

Home
Reset My Reset My Password
»

Password

Please enter your login name
employeejn@company.loc

What is your favorite color?

|blue ‘
What is your mother's maiden name?

[smitn |
What city were you born in?

cleveland

QIueChipJ

Cansulting Graup

©2003 Blue Chip Consulting Group, LLE, All rights reserved.

1 Answerthe three challengeguestions
T /£tA01 &/ KFy3aS tlaag2NRE

| BlueVault

Home
» Reset My Pac il Reset My Password

Processing transactionid: e51f015f-9725-4d99-ad1a-149c5908c583
employeejn@company.loc

Password:

Confirm Password:

sssssses

QIueChip_/

Comsulting Group

©2008 Blue Chip Consulting Group, LLC. All rights reservad.

1 Enter and confirntheir new password
T /ftA01 a{dzoYAl¢é



Password Change

Althoughusers dohave the ability to changéheir password viaBIM, this is not functionally different
than changingheir password at your worksti@n directly in Active Directory.

il BlueVault

Home
W \ Welcome to BlueVault Identity Manager

BlueVault Sign In:

Email: employeejn@company.lo)
To change your password, edit your profile, change your challenge questions ~ Password:
and answers or to request a name change, please select the "Self Service”
link.

2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Login toBIM

T { St SO0 {iSNDAGSEt Mikhsade? NJ |j dzi O]
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Home

Self-Service Change My Password
» Change Password Current Password

» Edit My Profile [essasses |

New Password

[eesssens |
Confirm Password

#» Request New Title L ]

» Challenge Questions
» Request Rename

Qluechip

Comsulting Group

®2009 Blue Chip Consulting Group, LLC, All rights reserved.

/] tA01 GKS a/ KFy3Bk ae tlFaagz2NRE ljdza O
Entertheir current password

Enter and confirntheir new password

/I £t A0l a{dzoYAlE

=A =4 =4 =



Profile Updating

Users lavethe ability to set profile attributes as well as view existing account information.

\BlueVault

Home
M \ Welcome to BlueVault Identity Manager

BlueVault Sign In:

Email: employeejn@company.loc)
To change your password, edit your profile, change your challenge questions ~ Password:
and answers or to reguest a name change, please select the "Self Service” -
link.

QlueCh

omesIR
2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Login toBIM

T { St SO0 {iSNDAGSEt Mikhsade? NJ |j dzi O]
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Home

Edit My Profile

Self-Service

» Change Password

Preferred First Name

» Edit My Profile D \
» Challenge Questions Login Name \ i
» Request Rename First Name ‘ ohn
» Request New Title Middle Name ‘
——
Last Name [Employee

Display Name

Description

Phone k (numeric)

lglue‘Chip

Censulting Grows

{StSOG GKS G9RAG aé tNBFAESE fAYy]
Userscan viewtheir existing account information.
Any attributes that are user editable will appear as a text input box

Enter the newprofile information
/I £t A01 a! LRFGS¢

=A =4 =4 4 =4



Request Rename

Usershave the ability to request a rename dfeir user information. This rename will have to be
approved bythe local HR represeative.

*Note: An account rename will also updateeir Active Directory loginemail address and / or all other
connected systems.

Ei BlueVault

Home
> Reset My|PASITT \ Welcome to BlueVault Identity Manager Bluevault Sign In:
Email:
To change your password, edit your profile, change your challenge questions ~ Password:
and answers or to request a name change, please select the "Self Service” ﬁ
link.
©2009 Blue Chip Consulting Group, LLC, All rights ressrved.
1 Login toBIM

T { St SO0 {iSNDAGSEt Mikhsade? NJ |j dzi O]



| BlueVault [T =

Home
Self-Service Warning: Requesting a rename will update your existing user id and email address.
» Change Password
» Edit My Profile ID ‘ |
» Challenge Questions Login Name I |
» Request Rename First Name ‘John |
» Request New Title Middle Name [ |

Last Name [Employee |

|

PreferredFirstName |

QlueChip

Cansulting Group

®2009 Blue Chip Consulting Group, LLC. All rights reserved.

T {StSOG GKS awSljdzSad wSylYSé fAy]

i Entertheir new name iformation

T /ftA01 GKS awSljdzSald wSylYS¢ odzidzy

1 An account rename request will be senttte local HR representative for approval.
1

Once the rename is approved. All associated attrilwlats, login names and email addresses
will automatically be updated



Update Title Request

Usershave the ability to request updated title informatiohis request system will help update

outdated HR systems that have not been manually kept up to dibtés request will have to be
approved bythe local HR representative.

ﬁ@;: BlueVault

Home
N \ Welcome to BlueVault Identity Manager BlueVault Sign In:

Email: -c'a_employeejn @company.log)
To change your password, edit your profile, change your challenge questions ~ Password:

and answers or to request a name change, please select the "Self Service” ﬁ
link.

lueChip_/

Camsulting Group

2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Loginto BIM
1 { St SOU {iSNI AcS&t Hink-heade NJ |j dzA O



) BlueVault —) = T

Home

D [ |

Login Name | ‘

Self-Service

» Change Password .
Title Information Technology ~

» Challenge Questions

» Request Rename

» Request New Title

%IueChip

uuuuuuuuu 1 Group

{ St SO0 GKS awSljdzSaid bSg ¢AlGfSéE tAY]
Selectthe correctnew title information

/I £t A01 GKS awSljdzSad bS¢ ¢AlGtSe odzidizy
A title update request will be sent the local HR representative for appral.



Self-Service Resource Request

Users have the ability to request that a resource be provisioned to them. For a resource to be available

in this section it has to be enabled for ssffrvice. See the Admin, Resource -Selfvice for further
details o seltservice enabling a resource.

Ei BlueVault

Home
N \ Welcome to BlueVault Identity Manager BlueVault Sign In:

Email: -c'a_employeejn @company.log)
To change your password, edit your profile, change your challenge questions ~ Password:

and answers or to request a name change, please select the "Self Service” ﬁ
link.

2009 Blus Chip Consulting Group, LLC, All rights reserved.

1 Login to BIM
1 { St SOU {iSN Ac St Hink-heade NJ |j dzA O



| BlueVault =) BT e

Home
A -- All - > —-All-- * —-All-- -
Self-Service Name Type Divisions Locations Owner
» Change Password Accounting Group Exchange Distribution List Company Corporate Cleveland Creekmore, Mark
» Edit My Profile
#» Challenge Questions Resource Details
» Request Rename Type Exchange Distribution List
Divisions Company Corporate
» RequestRSEESS Locations Cleveland
Name Accounting Group
Description Accounting Users DL

=

=A =4 =4 =4

(Note: requesting access will automatically request access for un-provisioned pre-requisites)

Pre-Requisites [,
No pre-requisites found!

Conflicting Resources
Mo conflicts found!

9ElueChip

Cansulting Group

{StSOG (GKS awSldzSaid ! 00Saa¢ ljdza O]l ft Ay
o This will show all resources that are available for-seif/ice at your location

Select the required resource

View the resource details, along with prequisites and confliction resources

/ £t A01 awSljdzSad ! 00Saas

A workflow approval will be sent to the resource owner. Once approved, you will be

automatically provisioned that resource.



Default Language Selection

BlueVault

is available in several different languagésserscan settheir default
language an®IMwill always change to that language ortbey login.

W BlueVault

Home .
» Raset My \ Welcome to BlueVault Identity Manager

BlueVault Sign In:

Email: employeejn@company.loc)
To change your password, edit your profile, change your challenge questions ~ Password:
and answers or to reguest a name change, please select the "Self Service” -
link.

..

Camsulting Gro:

nlp_/

®2003 Blue Chip Consulting Graup, LLC, All rights reserved.

1 Login to BIM

N BlueVault

Li ]

[Cogou] BN El—

H
o : \ Welcome to BlueVault Identity Manager
Self-Service

To change your password, edit your profile, change your challenge questions and answers or to request a
name change, please select the "Self Service” link.

QalueChipJ

Cansulting Group
®2009 Blue Chip Consulting Group, LLC. All rights reserved.

9 Click on the flag icon that correspondstiteir preferred langage
1 BIMwill change to that language



1 BlueVault 7] T

A I ST
Sk e

EETFEATED. ®EEA SR, Temake, PRINER. SERENET. BRE "AlRST iE.

QEE?BIl.w_-Ch

Consulting Graup

ip—~

©2009 Blue Chip Consulting Group, LLC, All rights reserved,

1 Example of BIM in Chinese
9 Ifthe userreset thar answers taheir challenge questions, the new questions will béheir
default language.



Manager Tasks

¢CKS YIFyF3aSNI GFralta | NB  2ddickiing Readdzy RSNJ 6 KS GLRSydAde

,;_ _: BlueVault (o] = e

| Home | Self-Service |
o Identity M t
Self-Service entity Managemen
Identity
o oo To view or modify non-employee accounts, click the "View/Modify" link.
iev/Nctly To add a new non-employee account, click the "Add" link.
» Add To delete a non-employee account, click the "Delete" link.
» Delete To request provisioning for a non-employee account, click the "Provisioning” link.
» Provisioning

©2003 Blue Chip Consulting Group, LLE, All rights reserved.

The following manager tasks are available:

View / modify managed account
Non-employee account request
Delete managed account
Terminate managed account
Provisioned resource request
Emergency account disable

=A =4 =4 =4 -8 =9



View / Modify Managed Account

This is used to view / modify account information foranagersdirect reports or managed nen
employee accounts.

m@% BlueVault (o] Sl § L[

| Home |
Home
! — Al - - Al v —All-- - |
Seif Sl Display Name D Last Name First Name Middle Name Disabled
Identity Contractor, Joe (Vendor) 100011 Contractor boe False

» View / Modify
» Add
» Delete

» Provisioning

Chip

Consulting Grewp

©2003 Blue Chip Consulting Group, LLE, All rights reserved.

This shows a list of all &f K S Y I diited &pbXsdand managed neemployee accountsUse the
drop down lists and filter box to naow the search.



‘ i BlueVault == =T

| Home | Seif-service |

Home

— All -- - Al - Al - |

Self-Service Display Name D Last Name First Name Middle Name Disabled
Identity Contractor, Joe (Vendor) 100011 Contractor Joe False

» View/Modify
» Add Login Name
» Delete

Type

» Provisioning

First Name

Middle Name

Last Name

Preferred First Name

Display Name

Description

Division Corporate

Location Warsaw

Employee, John
owner

Termination Date |

“*BlueChip

Comsulting Group

©2009 Blue Chip Consulting Group, LLC, All rights reserved.

9 Select an account to see further information
f ¢2 Y2RAFe (GKS | O02dzyiz Of AO01 (KS daz2RATe&é¢ odzidi
o This allowsx manageto do the following tasks:
Edit the display name
Edit the description
Change the division codq€ategory Code 1)
Change hie location cod¢Category Code 2)
Change theaccountowner/ manager
Set a Termination Date
9 The account will be automatically disabled on that date
Terminate Now
1 Immediate termination of the account

>~ >~ >~ >~ >~ >~

>~



Ei BlueVault (] Sl § Y B

 Home | seft-service |

Home

— Al - - Al v -l -

Seir S Display Name 1D Last Name First Name Middle Name Disabled
Identity Contractor, Joe (Vendor) 100011 Contractor Joe False

» View /Modify
» Add Login Name
» Delete

Type

» Provisioning

First Name

Middle Name

Last Name |

Preferred First Name |

Display Name |Contrar:tnr,Joe (Vendor)

Description [

Division Corporate =

Location Cleveland -

Enter owner filter below.

Employee, John
Owner ploves:

Termination Date

“BlueChip

Consulting Gre

©2003 Blue Chip Consulting Group, LLC, All rights reserved.

Thedisplay name and description atfree forme text fields and can be manually edited.

The two category codes (used for division and location in this instance) can be selected via drop down
boxes.

To change the account owner / manager:

Enter the account owner filter string in the filter text box.

Press <Emtr>

The list of accounts that match the filter criteria will be displayed
Select the new account owner

/I £t A0l a{l @S¢

= =4 =4 =8 =9

*Note: You will no longer be able to view or edit this account; those rights will belong to the new owner
/ manager

To set a termination da for the account:

9V i AY GKS F2NX 2F GYYKkRRkeeeeaé 2N dz&
It

>
O« »
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1 1
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Non-Employee Account Request

¢ KS a&! RIRE alldivsain@rigerto request the creation of a neamployee account. The following

account types are avalbée:

Admin account

Contact account (Email Contact)
Generic account

Mailbox only account

Service account

Test account

Vendor / contractor account

=A =4 =4 =4 -8 -8 9

m@i BlueVault (o]

| Home |
Home
i Type Vendor account -
Self-Service First N | ‘
irst Name

EdenbEg Middle Name [ |
» View/Modify Last Name | ‘
LT PreferredFirstName | |
& DeIeT:e. ] Display Name [ |
» Provisioning Description | ‘

Division Corporate -

Location Cleveland -

Enter awner filter below...
Owner

Termination Date | ‘

©2009 Blue Chip Consulting Group, LLC. All rights reserved.

To request a new neamployee account:

9 Select the account type

91 Enter the required attribute information
I Seletthe division and location codes

1 Select the ownef manager

1 Enter the Termination Date (if required)
1 /tA01 4! RRE

BTN A Bl

When the account is approved for creation, the account credential details will be emailee tovner /

manager



Delete Managed Account

Ths allowsa manageto delete a managedon-employeeaccount. The account is flagged as deleted in
BIM, but is not physically deleted from the database. The account will no longer app@#.in

| BlueVault

] {Cogat ] BTN Bl —
[ Home |
Home
" Vendor account v Al -- v Al - -
Self-Service Display Name D Last Name First Name Middle Name Disabled
Identity Contractor, Joe (Vendor) 100011 Contractor Joe False
» View/Modify
» Add Login Name [ |
» Delete Type | |
» Provisioning Eirst N | |
irst Name
Middle Name [ |
Last Name [ |
Preferred First Name | |
Display Name [ |
-
Description | |
Division Corporate
Location Cleveland
Employee, John
Owner

Termination Date |

®2003 Blue Chip Consulting Group, LLC. All rights reserved.

I Select the account
1 View the details of the account
f Clickthed 5SSt StS¢ odzid2y

*Note:
associated with that account.

Depending on theBIM / ILM configuration. This could delete all other accounts that

are



Provisioned Resource Request

This allowsx manageto request that a resource be provisioned to an existingoant

) BlueVault m BT

| Home | Self-Service |

Home
—All - > —All- > —All- -
Self-Service Display Name D Last Name First Name Middle Name Disabled
Identity Contractor, Joe (Vendor) 100011 Contractor Joe False
» View/Modify Division Location|Provisioned Resources| Description Select]
» Add Company CorporateGlobal  |Active Directory Company.local AD Account []
» Provisioning
Division Location|Available Resources Description Select]
Company CorporateCleveland Accounting Group |Accounting Users DL 1}
Company Corporate/Cleveland Corporate A5400 Corporate AS400 Account 1}
Company CorporateGlobal Exchange 2007 Exchange 2007 Mailbox /|
Company CorporateGlobal Portal Administrators  |[DPortal Admin Access |}
Company CorporateGlobal Portal HR IDPortal HR. Access |} L)
Company CorporateGlobal Portal Managers IDPortal Manager Access |}
Company CorporateGlobal Portal Reports IDPortal Reporting Access 1}
Company CorporateGlobal Portal Resource Owners[DPortal Resource Owner Access| []

[ Reauest Provsionng ]
QueChip

cansulting Grous

®2009 Blue Chip Consulting Graup, LLC. All rights reserved.

1 Select theaccountto request a resource for

9 This shows the current provisioned resources and the available resources
9 Select one or more available resources

T /ftA01 awSldzSad t NPGAaAA2YyAYyAE

When the provisioning request is approved, the resource witbmatically be provisioned to the
account.



Emergency Account Disable

This allows you to disable access for that account on all provisioned resources.

W BlueVault o

EEN==le [E—

Home
— All - v —Al—- v Al - |
Self-Service Display Name | 1D |  LastName |  First Name | Middle Name | Disabled
Identity !:untractor, Joe (Vendor) 100011 |Contractor Joe | False
» View/Modify Division |Location|Provisioned Resourceg‘ Description Sele%
» Add Company CorporateGlobal ctive Directory Company.local AD Account []
» Provisioning
| B Division Location|Available Resources Description Select]
Company CorporateCleveland Accounting Group |Accounting Users DL 1}
Company Corporate/Cleveland Corporate A5400 Corporate AS400 Account 1}
Company CorporateGlobal Exchange 2007 Exchange 2007 Mailbox /|
Company CorporateGlobal Portal Administrators  |[DPortal Admin Access |}
Company CorporateGlobal Portal HR IDPortal HR. Access |} L)
Company CorporateGlobal Portal Managers IDPortal Manager Access |}
Company CorporateGlobal Portal Reports IDPortal Reporting Access 1}
Company CorporateGlobal Portal Resource Owners[DPortal Resource Owner Access| []

®2009 Blue Chip Consulting Graup, LLC. All rights reserved.

i Select the account that tbe disablel
1

- A

/ tA01 GKS a9YSNBESyOe 5AalofsS

qweChip

cansulting Grous



9 The account is nowisabled
 ToreSylofS GKS I-ORafysé Of A01 aws

*Note: This action will also disable all provisioned resources for that account and remove all provisioned
group memberships.










































































































































































































































